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C H A P T E R 6

Turn Up a Network

This chapter explains how to turn up and test a Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) network. For DWDM topology reference information and span loss tables, see 
the “Network Reference” chapter in Cisco ONS 15454 DWDM Reference Manual.

There are two main DWDM network types: metro core, where the channel power is equalized and 
dispersion compensation is applied, and metro access, where the channels are not equalized and 
dispersion compensation is not applied. The DWDM network topologies supported are hubbed rings, 
multihubbed rings, meshed rings, linear configurations, and single-span links. The DWDM node types 
supported are hub, terminal, optical add/drop multiplexing (OADM), reconfigurable optical add/drop 
multiplexing (ROADM), anti-amplified spontaneous emissions (anti-ASE), and line amplifier. For 
DWDM and hybrid node turn-up procedures, see Chapter 3, “Turn Up a Node.”

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-G51 Verify DWDM Node Turn Up, page 6-2—Complete this procedure before beginning 
network turn-up.

2. NTP-G52 Verify Node-to-Node Connections, page 6-3—Complete this procedure next.

3. NTP-G201 Configure the Raman Pump on an MSTP Link, page 6-4—Complete this procedure to 
set the Raman total power and Raman ratio.

4. NTP-G53 Set Up Timing, page 6-22—Complete this procedure next.

5. NTP-G54 Provision and Verify a DWDM Network, page 6-28—Complete this procedure next.

6. NTP-G56 Verify the OSNR, page 6-33—Complete as needed.

7. NTP-G142 Perform a Protection Switch Test, page 6-35—Complete as needed.

8. NTP-G164 Configure Link Management Protocol, page 6-37—Complete as needed.

9. NTP-G233 Configure Link Management Protocol on the Cisco CRS-1 Router and the Cisco ONS 
15454 DWDM Node, page 6-44—Complete as needed.

10. NTP-G57 Create a Logical Network Map, page 6-62—Complete as needed.

11. NTP-G325 View the Power Levels of Cisco ONS 15454 MSTP Nodes, page 6-63—Complete as 
needed.
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12. NTP-G326 Provision SRLG on the Cisco ONS 15454 MSTP Network, page 6-64—Complete as 
needed.

NTP-G51 Verify DWDM Node Turn Up

Step 1 Log in to an ONS 15454 node on the network that you will test. See the “DLP-G46 Log into CTC” task 
on page 2-26 for instructions. If you are already logged in, continue with Step 2.

Step 2 Click the Alarms tab. 

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on 
page 9-27 as necessary.

b. Verify that no equipment alarms appear (EQPT in the Cond column) indicating equipment failure or 
other hardware problems. If equipment failure alarms appear, investigate and resolve them before 
continuing. Refer to the Cisco ONS 15454 DWDM Troubleshooting Guide for procedures.

Step 3 Verify that the software version shown in the node view (single-shelf mode) or multishelf view 
(multishelf mode) status area matches the version required by your network. (The status area is located 
to the left of the shelf graphic.) If the software is not the correct version, perform one of the following 
procedures:

• Perform a software upgrade using a Cisco ONS 15454 software CD or Cisco ONS 15454 SDH 
software CD. Refer to the release-specific software upgrade document.

• Replace both TCC2/TCC2P cards with cards containing the correct release.

Step 4 Click the Provisioning > General tabs. Verify that all general node information settings are correct 
according to documentation provided by the network administrator. If not, see the “NTP-G80 Change 
Node Management Information” procedure on page 10-11.

Step 5 Click the Provisioning > Network tabs. Ensure that the IP settings and other Cisco Transport Controller 
(CTC) network access information is correct according to documentation provided by the network 
administrator. If not, see the “NTP-G81 Change CTC Network Access” procedure on page 10-22.

Step 6 Click the Provisioning > Protection tabs. Verify that all required protection groups have been created 
according to documentation provided by the network administrator. If not, see the “NTP-G33 Create a 
Y-Cable Protection Group” procedure on page 5-19 or the “NTP-G83 Modify or Delete Card Protection 
Settings” procedure on page 10-39.

Step 7 Click the Provisioning > Security tabs. Verify that all users have been created and that their security 
levels are correct according to documentation provided by the network administrator. If not, see the 
“NTP-G88 Modify Users and Change Security” procedure on page 10-54.

Purpose This procedure verifies that each ONS 15454 is ready for DWDM network 
turn-up before adding nodes to a network. This procedure applies to all 
ROADM, OADM, and line-amplifier nodes.

Tools/Equipment Network plan provided by your network administrator

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 8 If Simple Network Management Protocol (SNMP) is provisioned on the node, click the Provisioning > 
SNMP tabs. Verify that all SNMP settings are correct according to documentation provided by the 
network administrator. If not, see the “NTP-G89 Change SNMP Settings” procedure on page 10-66.

Step 9 Repeat this procedure at each node in the network.

Stop. You have completed this procedure.

NTP-G52 Verify Node-to-Node Connections

Note In this procedure, Side A refers to Slots 1 through 6, and Side B refers to Slots 12 through 17.

Step 1 Check to see if the fibers coming from the adjacent nodes are connected to the OPT-BST, OPT-BST-E, 
OPT-AMP-17-C (operating in the booster amplifier mode), or OSC-CSM card LINE RX and TX ports. 
If yes, continue with Step 2. If adjacent node fibers are not connected to the LINE RX and TX ports, do 
not continue. Install the cabling to the adjacent nodes using the “NTP-G34 Install Fiber-Optic Cables on 
DWDM Cards and DCUs” procedure on page 3-72.

Step 2 Verify the following network fiber connections:

• The node’s Side A ports (LINE TX and RX) are connected to the Side B ports (LINE RX and TX) 
of the adjacent node.

• The node’s Side B ports (LINE RX and TX) are connected to the Side A ports (LINE TX and RX) 
of the adjacent node.

Step 3 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the network node that you want to verify.

Step 4 Click the Provisioning > Comm Channels > OSC tabs. Verify that OSC terminations appear under the 
OSC Terminations area for the Side B and Side A OSC-CSM or OSCM cards and that the port state is 
In-Service and Normal (IS-NR [ANSI]/Unlocked-enabled [ETSI]). If so, continue with Step 5. If OSC 
terminations are not created, complete the “NTP-G38 Provision OSC Terminations” procedure on 
page 3-121.

Step 5 Complete the “NTP-G76 Verify Optical Span Loss Using CTC” procedure on page 10-2 for all 
OSC-CSM cards. If the measured span loss is within the minimum and maximum expected span loss 
values, continue with Step 6. If not, clean the fiber connected to the OPT-BST, OPT-BST-E, 
OPT-AMP-17-C (operating in the booster amplifier mode), or OSC-CSM cards on both ends of the span, 
then repeat the “NTP-G76 Verify Optical Span Loss Using CTC” procedure on page 10-2. If the span 
loss is within the minimum and maximum expected span loss values, continue with Step 6. If not, contact 
your next level of support. 

Purpose This procedure verifies optical service channel (OSC) terminations 
between nodes and checks span attenuation. This procedure applies to all 
ROADM, OADM, and line-amplifier locations.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 6-2

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Repeat Steps 2 through 5 at each network node.

Stop. You have completed this procedure.

NTP-G201 Configure the Raman Pump on an MSTP Link

Step 1 The Raman pump can be configured in three ways:

• DLP-G468 Configure the Raman Pump Using the Installation Wizard, page 6-4—This procedure is 
the preferred and recommended installation process.

• DLP-G474 Configure the Raman Pump by Importing the CTP XML File, page 6-20—Use this 
procedure when the span is longer than 42 dB (expand on span). This procedure is not recommended 
for spans of 42 dB or less.

• DLP-G489 Configure the Raman Pump by Setting the ANS Parameters Manually, page 6-20—Use 
this procedure if the Raman installation wizard fails and expert intervention is required.

Stop. You have completed this procedure.

DLP-G468 Configure the Raman Pump Using the Installation Wizard

Purpose This procedure configures the Raman pump on an Multiservice Transport 
Platform (MSTP) link. 

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure configures the Raman Pump on an MSTP link using the 
installation wizard.

Tools/Equipment None

Prerequisite Procedures • DLP-G46 Log into CTC, page 2-26

• NTP-G30 Install the DWDM Cards, page 3-58

• NTP-G51 Verify DWDM Node Turn Up, page 6-2

• NTP-G37 Run Automatic Node Setup, page 3-122.

• Create an optical service channel (OSC) termination link by 
completing the “NTP-G38 Provision OSC Terminations” procedure on 
page 3-121 or create an optical transport section (OTS) provisionable 
pathcord terminations on line ports by completing “NTP-G184 Create 
a Provisionable Patchcord” procedure on page 7-51, as required.

Required/As Needed Required
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Note The installation wizard performs optical measurements and data exchange between the nodes. Make sure 
that the data communications network (DCN) is stable.

Note Running the installation wizard without setting the automatic node setup (ANS) parameters causes the 
wizard to fail. Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-122.

Note Running the installation wizard can impact traffic. Make sure that nobody is working on the nodes before 
continuing with this procedure.

Caution To perform optical measurements, the installation wizard automatically turns on hardware resources 
installed on the nodes. Alarms can occur during the installation process. Following the recommendations 
is critical to the success of installation.

Note Make sure that a Muxponder, a WSS, or a tunable transponder is present before you run the Raman 
installation wizard.

Note When the span is longer than 42 dB, do not use the Raman installation wizard.

Step 1 From the CTC View menu, choose Go to Network View.

Step 2 Figure 6-1 shows a sample network view of nodes (terminal or ROADM) connected in the network. 

Onsite/Remote Onsite and remote

Security Level Provisioning or higher
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Figure 6-1 Network View of Nodes (Terminal or ROADM)

The Raman pump on the OPT-RAMP-C or OPT-RAMP-CE card can be configured on a single span or 
multiple spans.
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Step 3 To start the Raman installation wizard, complete one of the following steps:

• To configure Raman amplification on a single span, go to Network view, right-click on a single node 
or span and choose Raman Installation Day0 from the shortcut menu. (Figure 6-2). Go to Step 5.

• To configure Raman amplification on multispans, go to Network view, right-click on a specific span, 
and choose Raman Installation Day0 Multi-span from the shortcut menu (Figure 6-3).

Figure 6-2 Installing the Raman Pump on a Single Span
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Figure 6-3 Installing the Raman Pump on Multiple Spans

The Routing page is displayed (Figure 6-4).
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Figure 6-4 Selecting Spans for Raman Amplification

The Included Span list box lists all spans in the network.

Step 4 Select a span from the network to add a span.

If you are setting up multispans, make sure that the span selection is made in a sequence; otherwise, an 
error message is displayed. For example, in Figure 6-4, begin with the span between the nodes 
WXC_BSTE_Chica-155 and OLA2_CrownP-154, and then the span between OLA2_CrownP-154 and 
OLAasym_Batavia-157, and so on.

Step 5 When you have selected the span or spans, click Next.

The Setting Parameters page is displayed (see Figure 6-5). 
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Figure 6-5 Setting Raman Calibration Parameter

Note The Hints area displays the status of internal operations.

Note If multiple spans are selected, the applicable nodes are displayed on the left side of the page.

Step 6 Select one or more checkboxes as applicable:

• Autorun wizard—The Installation wizard tunes the selected span automatically, requiring no user 
intervention. However, if the wizard displays errors, the wizard requests for user 
acknowledgements.

• Even Band—This option is used for optical networks that support only even band channels. If the 
network supports odd and even channels, the Raman Installation wizard tunes the transponder to the 
first tunable odd band channel.

• Auto Skip Tune Path—The Raman Installation wizard skips spans that have been previously tuned 
by the wizard. 

• Bidirectional Path—This configures the OPT-RAMP-C or OPT-RAMP-CE cards in both directions 
(source to destination and destination to source)

• MUX/DMUX Present—This option is used if the optical network has transponders connected to 
the A/D stage (MUX or WSS).

Several scenarios are discussed in the following section. Select as applicable:
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• Check box Bidirectional Path is unchecked and check box MUX/DMUX Present is checked. See 
Figure 6-6 and Step 7a.

• Check box Bidirectional Path is unchecked and check box MUX/DMUX Present is unchecked. See 
Figure 6-7 and Step 7b.

• Check box Bidirectional Path is checked and check box MUX/DMUX Present is checked. See 
Figure 6-8 and Step 7c.

• Check box Bidirectional Path is checked and check box MUX/DMUX Present is unchecked. See 
Figure 6-9 and Step 7d.

Note Before you check the MUX/DMUX Present check box, ensure that the following prerequisites are 
completed: 

• At least one source node is a terminal node or a ROADM node.

• Two transponders/muxponders supporting wavelength of 1530.33 nm and 1560.61 nm, used as 
probe signals, are available on the source node for odd channels or wavelengths of 1530.72 nm and 
1561.01 nm for even channels.

• Trunk ports are connected to the correct ADD ports. 

Note The Raman Wizard does not verify if the selected TXP connections are properly connected. The 
calibration process is terminated if a LOS-P alarm is detected on the MUX input port when the trunk 
port is turned on.

Note If you do not use the MUX/DMUX Present check box, ensure that the following prerequisites are 
completed:

• Connect a UT2-based trunk port (from a transponder/muxponder card) to the COM-RX port of the 
booster amplifier connected to the OPT-RAMP-C or OPT-RAMP-CE card on the source node.

A full-spectrum, tunable interface allows the system to tune the signal on two required wavelengths 
without any human intervention.

• A 10-dB bulk attenuator must be connected between the TXP trunk port and the COM-RX port of 
the booster amplifier.

Caution Make sure that the bulk attenuator is removed as soon as installation finishes and the correct fiber is 
reconnected to the COM-RX port of the booster amplifier.

Step 7 Perform any one of the following steps, based on your selection in Step 6.

a. Select the two transponders on the source node from the Slot drop-down list. The installation wizard 
tunes the transponders to the required wavelengths. (Figure 6-6).
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Figure 6-6 Bidirectional Path Is Unchecked and MUX/DMUX Present Is Checked

b. Select one transponder on the source node from the Slot drop-down list. The installation wizard 
verifies if the transponder can tune on the first tunable wavelength. Make sure that the card used is 
a tunable C-band transponder and set the transponder to the “first tunable wavelength”. Otherwise, 
the wizard fails and the installation must be repeated using a correctly configured tunable 
transponder (Figure 6-7).

Note The wizard uses a pre-installed UT-2 based transponder.
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Figure 6-7 Bidirectional Path Is Unchecked and MUX/DMUX Present Is Unchecked

c. Select the two transponders on the source and destination nodes from the Slot drop-down list. The 
installation wizard verifies if the transponders are tuned to the expected wavelengths or on the first 
tunable wavelength. Otherwise, the wizard fails and the installation must be repeated (Figure 6-8).
6-13
Cisco ONS 15454 DWDM Procedure Guide, R9.1

78-18886-02



 

Chapter 6      Turn Up a Network
Before You Begin
Figure 6-8 Bidirectional Path Is Checked and MUX/DMUX Present Is Checked

d. Select a transponder on the source and destination nodes from the Slot drop-down list. The 
installation wizard verifies if the transponder can be tuned on the first tunable wavelength. Make 
sure that the transponder is a tunable C-band transponder. Otherwise, the wizard fails and the 
installation must be repeated (Figure 6-9).
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Figure 6-9 Bidirectional Path Is Checked and MUX/DMUX Present Is Unchecked

Step 8 Click Next. The Calibrate Raman Page is displayed (Figure 6-10).
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Figure 6-10 Calibrating Raman Amplification

The installation wizard changes the trunk port to the In-Service (IS) state and turns on all the amplifiers. 
All the OTS and optical channel (OCH) ports in the span are changed to IS state.

Step 9 As soon as the Raman calibrations are complete, the Next button is enabled. Click Next.
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Figure 6-11 Calibrating Raman Amplification

Step 10 The power received on the destination node when wavelength on the source is turned on is shown. If you 
installed Raman amplification on multiple spans, click Next to view results of other spans.

Step 11 If the installation wizard fails, click the Repeat button. The Raman installation wizard recalibrates the 
values on the destination node.

Note If you have repeated the calibration several times and the wizard fails, press Cancel to abort the 
installation process. Log in to the Cisco Technical Support Website at 
http://www.cisco.com/cisco/web/support/index.html for more information or call Cisco Technical 
Support at (800) 553-2447.

Step 12 Click Next. The Accept Results page is displayed (Figure 6-12).
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Figure 6-12 Raman Amplification Results

The calculated Raman power and Raman gain are displayed. (Figure 6-12.)

Step 13 The wizard compares the calculated Raman gain value with the expected results. Your action depends 
on the Raman gain values. 

• Expected gain (Gt) – 0.5 dB <= (gain) <= (expected gain) + 0.5 dB—If the Raman gain is within 
this range, it means that the setup procedure was successful (Figure 6-13). Click Next and Finish.

• 3.0 dB <= (gain) <= (expected gain) – 0.5 dB—If the Raman gain is within this range, it means that 
the values are slightly outside the range. The wizard recommends that you verify the span length 
and cabling, and repeat the installation wizard procedure. If the Raman gain values are still not 
within the expected value range even after repeating the installation process, you can choose to 
forcibly apply these values by clicking Force Calibration. However, we recommend that you log in 
to the Cisco Technical Support Website at http://www.cisco.com/cisco/web/support/index.html for 
more information or call Cisco Technical Support at (800) 553-2447.

• (gain) < (expected gain) – 3.0 dB or if (gain) < (expected gain) + 0.5 dB—If the Raman gain is within 
this range and the values calculated are far from the targeted results, the installation fails and the 
wizard recommends repeating the installation. If the results do not improve, it means that the 
installation process has failed. The Force Calibration option is not available. Click Cancel to abort 
the installation and log in to the Cisco Technical Support Website at 
http://www.cisco.com/cisco/web/support/index.html for more information or call Cisco Technical 
Support at (800) 553-2447.
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Note The reason that the calculated values are not within the range may be due to installation issues 
(for example, the actual fiber type is different than the one used by Cisco Transport Planner to 
design the link) or procedural issues.

Step 14 Click Exports Data to export the Raman setup tuning data in text format.

Step 15 Click Finish.

Note When an error occurs during calibration of multiple spans, the calibration process stops and the Force 
Calibration button becomes visible (Figure 6-13).

Note If an error occurs during calibration of multiple spans when using the AutoRun wizard, the calibration 
stops and the Force Calibration button becomes visible. (Figure 6-13). Click Force Calibration to force 
the results.

Figure 6-13 Force Raman Calibration

Step 16 Return to your originating procedure (NTP).
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DLP-G474 Configure the Raman Pump by Importing the CTP XML File

Step 1 Install the ANS parameters calculated using Cisco Transport Planner, by completing the “NTP-G143 
Import the Cisco TransportPlanner NE Update Configuration File” procedure on page 3-44.

Step 2 Launch, run, and apply ANS parameters by completing “NTP-G37 Run Automatic Node Setup” 
procedure on page 3-122.

Step 3 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-RAMP-C or 
OPT-RAMP-CE amplifier to display the card view.

Step 4 Click the Maintenance > APC & Restore tabs.

Step 5 Click Restore from Fiber Cut. This automatically restores the Raman gain on the other end of the span.

Step 6 Return to your originating procedure (NTP).

DLP-G489 Configure the Raman Pump by Setting the ANS Parameters Manually

Note This procedure can be performed only on a per-span basis and not on multiple spans. To configure 
multiple spans, repeat this procedure on each span that you want to configure.

Caution Running the Raman installation wizard can result is traffic interruption. Make sure that nobody is 
working on the nodes before continuing with this procedure.

Step 1 Launch, run, and apply ANS parameters by completing “NTP-G37 Run Automatic Node Setup” 
procedure on page 3-122.

Purpose This procedure configures the Raman pump by importing the Cisco 
Transport Planner XML file.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure configures the Raman pump by setting the ANS parameters 
manually.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed, when the wizard fails and expert intervention is required.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note The ANS parameters that must be manually provisioned in Step 1 are:

• (Slot i.OPT-RAMP-CE).Port RAMAN-TX.Raman Gain

• (Slot i.OPT-RAMP-CE).Port DC-TX.Power

• (Slot i.OPT-RAMP-CE).Port COM-TX.Power

• (Slot i.OPT-RAMP-CE).Port RAMAN-TX.Raman Ratio

• (Slot i.OPT-RAMP-CE).Port RAMAN-TX.Raman Power

• (Slot i.OPT-RAMP-CE).Port LINE-RX.Min Expected Span Loss

• (Slot i.OPT-RAMP-CE).Port LINE-RX.Max Expected Span Loss

• (Slot i.OPT-RAMP-CE).Port OSC-RX. OSC LOS Threshold

ANS parameters are displayed in the Provisioning > WDM-ANS > Provisioning tab. For more 
information, see the “Node Reference” chapter in the Cisco ONS 15454 DWDM Reference Guide.

Step 2 Complete the “NTP-G143 Import the Cisco TransportPlanner NE Update Configuration File” procedure 
on page 3-44.

Step 3 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-RAMP-C or 
OPT-RAMP-CE card to go to the card view.

Step 4 Click the Maintenance > APC & Restore tabs. This automatically restores the Raman gain on the other 
end of the span.

Step 5 Return to your originating procedure (NTP).

DLP-490 Restore Raman Link After a Fiber Cut Occurs

Note This procedure does not calculate the Raman pump ratio. The Raman pump ratio is not expected to 
change after the fiber cut is repaired.

Caution The procedure affects traffic. Make sure that nobody is working on the nodes before you begin.

Step 1 Complete the “NTP-G54 Provision and Verify a DWDM Network” procedure on page 6-28.

Purpose This procedure tunes Raman set-points after a fiber cut has been repaired. 
The Raman total power value is calculated again, and the original Raman 
gain is restored.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed. 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Make sure that the network traffic is restored.

Step 3 In node view (single-shelf mode) or shelf view (multishelf mode), double-click the OPT-RAMP-C or 
OPT-RAMP-CE amplifier to display the card view.

Step 4 Click the Maintenance > APC & Restore tabs.

Step 5 Click Restore from Fiber Cut. This automatically restores the Raman gain on the other end of the span.

Step 6 Return to your originating procedure (NTP).

NTP-G53 Set Up Timing

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at the node where you will set up timing. If 
you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G95 Set Up External or Line Timing” task on page 6-22 if an external building 
integrated timing supply (BITS) source is available. This is the most common ONS 15454 timing setup 
method. 

Step 3 If an external BITS source is not available, complete the “DLP-G96 Set Up Internal Timing” task on 
page 6-25. This task can provide only Stratum 3 timing. 

Step 4 Repeat this procedure at each node in the network.

Step 5 Return to your originating procedure (NTP).

DLP-G95 Set Up External or Line Timing

Step 1 In node view (single-node mode) or shelf view (multishelf mode), click the Provisioning > Timing > 
General tabs.

Step 2 In the General Timing area, complete the following information:

Purpose This procedure provisions Cisco ONS 15454 timing.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 6-2

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task defines the ONS 15454 timing source (external or line).

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Timing Mode—Choose External if the ONS 15454 derives its timing from a BITS source wired to 
the backplane pins (ANSI) or a MIC-C/T/P front-mount electrical connection (FMEC) (ETSI); 
choose Line if timing is derived from an OSC-CSM or OSCM card that is optically connected to the 
timing node. A third option, Mixed, allows you to set both external and line timing references. 
Because Mixed timing might cause timing loops, we do not recommend its use. Use this mode with 
care.

• SSM Message Set—Choose the Generation 2 synchronization status messaging (SSM) option. See 
the “Timing Reference” chapter in Cisco ONS 15454 DWDM Reference Manual for more 
information about SSM, including definitions of the SONET timing levels.

Note Generation 1 is used only by SONET or SDH ONS 15454 nodes that are connected to 
equipment that does not support Generation 2. 

• Quality of RES—Sets the timing quality for the user-defined, reserved (RES) S1 byte if your timing 
sources supports RES. Most timing sources do not use RES. If it does not support RES, choose 
RES=DUS (do not use for timing reference). Qualities are displayed in descending quality order as 
ranges. For example, in Generation 1 SSM, ST3<RES<ST2 means that the timing reference RES is 
higher than a Stratum 3 (ST3) and lower than a Stratum 2 (ST2).

• Revertive—Select this check box if you want the ONS 15454 to revert to a primary reference source 
after the conditions that caused it to switch to a secondary timing reference are corrected. 

• Reversion Time—If Revertive is checked, choose the amount of time that the ONS 15454 will wait 
before reverting to its primary timing source. Five minutes is the default.

Step 3 In the Reference Lists area, complete the following information:

Note You can define up to three timing references for the node and up to six BITS Out references. 
BITS Out references define the timing references used by equipment that can be attached to the 
node’s BITS Out pins on the backplane (ANSI) or the MIC-C/T/P FMEC (ETSI). If you attach 
equipment to BITS Out pins, you normally attach it to a node with Line mode, because 
equipment near the external timing reference can be directly wired to the reference. 

• NE Reference—Allows you to define three timing references (Ref 1, Ref 2, Ref 3). The node uses 
Reference 1 unless a failure occurs to that reference, in which case the node uses Reference 2. If 
Reference 2 fails, the node uses Reference 3, which is typically set to Internal Clock. Reference 3 
is the Stratum 3 clock provided on the TCC2/TCC2P card. The options that appear depend on the 
Timing Mode setting. 

– If the Timing Mode is set to External, your options are BITS-1, BITS-2, and Internal Clock.

– If the Timing Mode is set to Line, your options are the node’s working OSCM cards, OSC-CSM 
cards, transponder (TXP) cards, muxponder (MXP) cards, and Internal Clock. Choose the cards 
or ports that are directly or indirectly connected to the node wired to the BITS source. Set 
Reference 1 to the card that is closest to the BITS source. For example, if Slot 5 is connected to 
the node wired to the BITS source, choose Slot 5 as Reference 1.

– If the Timing Mode is set to Mixed, both BITS references and the OSCM, OSC-CSM, TXP, or 
MXP cards are available, allowing you to set a mixture of external BITS clocks and OSCM, 
OSC-CSM, TXP, or MXP cards as timing references.

• BITS-1 Out/BITS-2 Out—Sets the timing references for equipment wired to the BITS Out 
backplane (ANSI) or MIC-C/T/P FMEC (ETSI) pins. BITS-1 Out and BITS-2 Out are enabled when 
BITS-1 Out and BITS-2 Out facilities are put in service. If Timing Mode is set to external, choose 
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the OSCM, OSC-CSM, TXP, or MXP card used to set the timing. If Timing Mode is set to Line, you 
can choose an OSCM, OSC-CSM, TXP, or MXP card or choose NE Reference to have the BITS-1 
Out, BITS-2 Out, or both, follow the same timing references as the network element (NE).

Note All TXP or MXP card client ports are available for timing regardless of the card’s 
termination mode. TXP or MXP trunk ports can be a timing reference when ITU-T G.709 is 
set to OFF and the Termination Mode is set to LINE. You cannot choose TXP_MR_2.5G and 
OTU2_XP card client ports as a timing reference.

Note The system prevents BITS In and BITS Out timing to be set on the same node.

Step 4 Click Apply.

Step 5 Click the BITS Facilities tab.

Note The BITS Facilities section sets the parameters for your BITS-1 and BITS-2 timing references. 
Many of these settings are determined by the timing source manufacturer. If equipment is timed 
through BITS Out, you can set timing parameters to meet the requirements of the equipment.

Step 6 In the BITS In area, complete the following information:

• Facility Type—(TCC2P card only) Choose the BITS signal type supported by your BITS clock, 
either DS1 or 64Khz+8Khz. 

• BITS In State—If Timing Mode is set to External or Mixed, set the BITS In state for BITS-1, 
BITS-2, or both, to IS (in service) depending on whether one or both BITS input pin pairs are 
connected to the external timing source. If Timing Mode is set to Line, set the BITS In state to OOS 
(out of service). 

Step 7 If the BITS In state is set to OOS, continue with Step 8. If the BITS In state is set to IS, complete the 
following information:

• Coding—Choose the coding used by your BITS reference, either B8ZS (binary 8-zero substitution) 
or AMI (alternate mark inversion).

• Framing—Choose the framing used by your BITS reference, either ESF (Extended Super Frame) or 
SF (D4) (Super Frame). 

• Sync Messaging—Check this check box to enable SSM. SSM is not available if Framing is set to 
Super Frame.

• Admin SSM—If the Sync Messaging check box is not checked, you can choose the SSM 
Generation 2 type from the drop-down list. Choices are PRS (Primary reference source; Stratum 1), 
ST2 (Stratum 2), TNC (Transit Node Clock), ST3E (Stratum 3E), ST3 (Stratum 3), SMC (SONET 
minimum clock), and ST4 (Stratum 4).

Step 8 In the BITS Out area, complete the following information, as needed:

• Facility Type—(TCC2P only) Choose the BITS Out signal type, either DS1 or 64Khz+8Khz.

• BITS Out state—If equipment is connected to the node’s BITS output pins on the backplane (ANSI) 
or MIC-C/T/P FMEC (ETSI) and you want to time the equipment from a node reference, set the 
BITS Out state for BITS-1, BITS-2, or both, to IS, depending on which BITS Out pins are used for 
the external equipment. If equipment is not attached to the BITS output pins, set the BITS Out state 
to OOS. 
6-24
Cisco ONS 15454 DWDM Procedure Guide, R9.1

78-18886-02



 

Chapter 6      Turn Up a Network
Before You Begin
Step 9 If the BITS Out state is set to OOS, continue with Step 10. If the BITS Out state is set to IS, complete 
the following information:

• Coding—Choose the coding used by your BITS reference, either B8ZS or AMI.

• Framing—Choose the framing used by your BITS reference, either ESF or SF (D4). 

• AIS Threshold—If SSM is disabled or Super Frame is used, choose the quality level where a node 
sends an alarm indication signal (AIS) from the BITS 1 Out and BITS 2 Out backplane pins (ANSI) 
or MIC-C/T/P FMEC (ETSI). An AIS alarm is raised when the optical source for the BITS reference 
falls to or below the SSM quality level defined in this field.

• LBO—If an external device is connected to the BITS Out pins, set the line build-out (LBO) distance 
between the ONS 15454 and an external device. If an external device is connected to BITS Out, 
choose the distance between the device and the ONS 15454. Options are: 0-133 ft (default), 134-266 
ft, 267-399 ft, 400-533 ft, and 534-655 ft. Line build out (LBO) relates to the BITS cable length. If 
an external device is not connected to BITS Out, leave this field set to the default.

Step 10 Click Apply.

Note Refer to Cisco ONS 15454 DWDM Troubleshooting Guide for timing-related alarms. 

Step 11 Return to your originating procedure (NTP).

DLP-G96 Set Up Internal Timing

Caution Internal timing is Stratum 3 and is not intended for permanent use. All ONS 15454 SONET (ANSI) or 
SDH (ETSI) nodes should be timed to a Stratum 2 (or better) primary reference source. Internal timing 
is appropriate for DWDM nodes.

Step 1 In node view (single-node mode) or shelf view (multishelf mode), click the Provisioning > Timing > 
General tabs.

Step 2 In the General Timing area, enter the following:

• Timing Mode—Set to External.

• SSM Message Set—Set to Generation 1.

• Quality of RES—Does not apply to internal timing.

• Revertive—Does not apply to internal timing.

• Reversion Time—Does not apply to internal timing.

Purpose This task sets up internal timing (Stratum 3) for an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed (use only if a BITS source is not available) 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 In the Reference Lists area, enter the following information:

• NE Reference 

– Ref 1—Set to Internal Clock.

– Ref 2—Set to Internal Clock.

– Ref 3—Set to Internal Clock.

• BITS-1 Out/BITS-2 Out—Set to None.

Step 4 Click Apply.

Step 5 Click the BITS Facilities tab.

Step 6 In the BITS Facilities area, change the BITS In state and BITS Out state to OOS for BITS 1 and BITS 2. 
Disregard the other BITS Facilities settings; they are not relevant to internal timing.

Step 7 Click Apply.

Step 8 Return to your originating procedure (NTP).

DLP-G350 Use the Cisco Transport Planner Traffic Matrix Report

Step 1 Display a printed copy of the Cisco Transport Planner Traffic Matrix report for your network. 
Figure 6-14 shows an example of the Traffic Matrix report in Cisco Transport Planner. The report can be 
exported in Microsoft Excel (.xls) or HTML format.

Purpose This task describes how to use the Cisco Transport Planner traffic matrix 
report to provision and verify a DWDM network.

Tools/Equipment None

Prerequisite Procedures NTP-G139 Verify Cisco TransportPlanner Reports and Files, page 3-3

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Figure 6-14 Cisco Transport Planner Traffic Matrix Report

Step 2 View the following information:

• Service Demand—Lists the general service demand from site to site.

• Service Circuit—Lists the service circuit.

• OCH-CC Src—Lists the optical channel client connection (OCHCC) source site and the shelf 
direction, either Side B or Side A. 

• OCH-CC Src Position—Lists the OCHCC source rack, shelf, and slot.

• OCH-CC Src Unit—Lists the OCHCC source TXP, MXP, or ITU-T line card.

• OCH-CC Src Port—Lists the OCHCC source port.

• A/D Src Position—Lists the optical channel add/drop card source rack, shelf, and slot.

• A/D Src Unit—Lists the optical channel add/drop card source TXP, MXP, or ITU-T line card.

• A/D Src Port—Lists the optical channel add/drop card source port.

• OCH-CC Dst—Lists the OCHCC destination site and shelf direction, either Side B or Side A. 

• OCH-CC Dst Position—Lists the OCHCC destination rack, shelf, and slot.

• OCH-CC Dst Unit—Lists the OCHCC destination TXP, MXP, or ITU-T line card.

• OCH-CC Dst Port—Lists the OCHCC destination port.

• A/D Dst Position—Lists the optical channel add/drop card destination rack, shelf, and slot

• A/D Dst Unit—Lists the optical channel add/drop card destination TXP, MXP, or ITU-T line card.

• A/D Dst Port—Lists the optical channel add/drop card destination port.

– Dest Unit is the product ID of the optical path source card.

– Dest Port is the port label reported on the front panel of the optical path destination card.
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• Cl Service Type—Identifies the service type of the optical channel.

• Protection—Identifies the type of protection used for the optical channel:

– Optical paths for unprotected-Side B and unprotected-Side A optical channels are routed along 
one direction only in the network.

– Optical paths for Y-cable, fiber-switched, and client 1+1 optical channels are routed along two 
independent directions in the network.

• Op Bypass Site Name—Identifies where the optical channel is dropped and reinserted when it is not 
terminated on a TXP or MXP card (optical bypass).

Note If the word None appears in the Op Bypass Site Name column, no optical bypass is defined 
for the optical channel.

• Wavelength—Identifies the wavelength used for the optical channel. Table 7-2 on page 7-7 lists the 
thirty-two available wavelengths.

• DWDM Interface Type—Identifies the DWDM interface type that is used for the optical channel:

– Transponder indicates that a transponder (TXP), muxponder (MXP), or DWDM pluggable port 
module is used for the optical channel.

– Line Card indicates that an ITU line card is used for the optical channel.

• DWDM Card Type—Identifies the type of TXP or line card that is used for the optical channel. For 
information about card types supported by Cisco Transport Planner, see Cisco Transport Planner 
DWDM Operations Guide.

Step 3 Return to your originating procedure (NTP).

NTP-G54 Provision and Verify a DWDM Network

Purpose This procedure verifies the performance of all cable connections and cards 
in a network topology. You can also use this procedure to troubleshoot any 
problems with DWDM network set up. 

Tools/Equipment Test set or protocol analyzer

Cisco Transport Planner Traffic Matrix
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Note In this procedure, Side A refers to Slots 1 through 6, and Side B refers to Slots 12 through 17.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 to log in to an ONS 15454 node on the 
network.

Step 2 Click the Alarms tab:

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on 
page 9-27, as necessary.

b. Verify that no equipment (EQPT) alarms appear. If equipment failure alarms appear, investigate and 
resolve them before continuing. Refer to Cisco ONS 15454 DWDM Troubleshooting Guide for 
procedures.

Step 3 Using the Cisco Transport Planner Traffic Matrix (see Table 3-1 on page 3-4) for your site, identify the 
first channel (ITU wavelength) to be provisioned. Use the TXP, MXP, or line card that corresponds to 
the selected wavelength.

Step 4 For the ITU wavelength identified in Step 3, create an optical channel client connection (OCHCC) 
circuit or optical channel network connection (OCHNC) circuit using one of the following tasks: 

• DLP-G346 Provision Optical Channel Client Connections, page 7-4.

• DLP-G105 Provision Optical Channel Network Connections, page 7-22.

.After creating the OCHCC or OCHNC circuit, return to this procedure and continue with Step 5.

Note Every time a channel is created in the DWDM network, the amplifiers automatically calculate 
the optical output power needed to maintain a constant power level on each channel. Automatic 
power control (APC) also starts every 60 minutes. If the span length changes, APC modifies 
amplifier gains and modifies express variable optical attenuation (VOA). For more information 
about APC, see the “Network Reference” chapter in Cisco ONS 15454 DWDM Reference 
Manual.

Prerequisite Procedures DLP-G277 Provision a Multirate PPM, page 5-10

DLP-G278 Provision the Optical Line Rate, page 5-13

NTP-G96 Provision the 10G Multirate Transponder Card Line Settings, 
PM Parameters, and Thresholds, page 5-47

NTP-G97 Modify the 4x2.5G Muxponder Card Line Settings and PM 
Parameter Thresholds, page 5-95

NTP-G98 Provision the 2.5G Multirate Transponder Card Line Settings 
and PM Parameter Thresholds, page 5-27

NTP-G99 Modify the 2.5G Data Muxponder Card Line Settings and PM 
Parameter Thresholds, page 5-116

NTP-G148 Modify the 10G Data Muxponder Card Line Settings and PM 
Parameter Thresholds, page 5-134

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 In node view (single-shelf mode) or multishelf view (multishelf mode), click the Circuits tab. Verify that 
the OCHCC or OCHNC created in Step 4 has a DISCOVERED status and an IS state. If so, continue 
with Step 6. If not, complete “NTP-G183 Diagnose and Fix OCHNC and OCH Trail Circuits” task on 
page 7-42.

Step 6 Click the circuit and click Edit.

Step 7 In the Edit Circuit dialog box, click the State tab.

Step 8 In the Cross-Connections table, verify that the circuit path is correct and record all the nodes that appear 
in the Node column. The first node is the circuit source, and the last node is the circuit destination. If the 
circuit path is incorrect, delete the circuit and go back to Step 4 to create a new circuit.

Step 9 Display the circuit source node in node view (single-shelf mode), or shelf view (multishelf mode). If an 
OPT-PRE card or OPT-AMP-17-C card (operating in the preamplifier mode) is installed, complete the 
following steps. If not, continue with Step 10.

a. Display the OPT-PRE or OPT-AMP-17-C card in card view.

b. Click the Provisioning > Opt.Ampli.Line > Parameters tabs.

c. Check the value of the Port 2 (COM-TX) Signal Output Power:

– If the OPT-PRE or OPT-AMP-17-C card is not carrying traffic, the values do not match. Skip 
this step and go to Step 10.

– If the value is equal to or greater than the value shown in the Channel Power Ref table cell, 
continue with Step d.

– If the value is lower than the value shown in the Channel Power Ref table cell, contact your next 
level of support.

– If a 40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE card is installed, check the power on 
the DROP-TX port of the card on Side A.

d. If a second OPT-PRE or OPT-AMP-17-C card is installed, repeat Steps a through c for the second 
OPT-PRE card. If not, continue with Step 10.

Step 10 If an OPT-BST card, or OPT-AMP-17-C card, or OPT-AMP-L card (provisioned in OPT-PRE mode) is 
installed, complete the following steps. If not, continue with Step 11.

a. Display the OPT-BST, OPT-AMP-17-C, or OPT-AMP-L card in card view.

b. Click the Provisioning > Opt.Ampli.Line > Parameters tabs.

c. Check the value of the Port 6 (COM-TX) Signal Output Power:

– If the OPT-BST, OPT-AMP-17-C, or OPT-AMP-L card is not carrying traffic, the values do not 
match. Skip this step and go to Step 11.

– If the value is equal to or greater than the value shown in the Channel Power Ref table cell, 
continue with Step d.

– If the value is lower than the value shown in the Channel Power Ref table cell, contact your next 
level of support.

d. If a second OPT-BST, OPT-AMP-17-C, or OPT-AMP-L is installed, repeat Steps a through c for the 
second OPT-BST, OPT-AMP-17-C, or OPT-AMP-L card. If not, continue with Step 11.

Step 11 If the node is a ROADM with 32WSS and 32DMX or 32DMX-O cards installed, or is a ROADM with 
40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE cards installed and the circuit is an Add/Drop 
circuit, complete the following steps. If neither scenario applies, continue with Step 12.

a. In node view (single-node mode) or multishelf view (multishelf mode) click the Provisioning > 
WDM-ANS > Provisioning tabs. 
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b. In the Selector area, click one of the following parameters: 

– Power on the CHAN-TX i port of the 32-DMX-O card on Side A where i = 1 through 32 for the 
channel carrying the circuit.

– Power on the CHAN-TX i port of 32-DMX card on Side A

– Power on the CHAN-TX i port of 40-DMX-C/40-DMX-CE card on Side A

c. Record the value located in the Value table cell for one of the following: 

– Power on the CHAN-TX i port of the 32-DMX-O card on Side A where i = 1 through 32 for the 
channel carrying the circuit (if a 32DMX-O card is installed).

– Power on the CHAN-TX i port of 32-DMX card on Side A (if a 32DMX card is installed).

If the value is not present, skip this step and continue with Step d.

d. Display the 32DMX card or 40-DMX-C/40-DMX-CE installed on Side A in card view.

e. Click the Provisioning > Optical Chn > Parameters tabs.

f. Locate the channel that carries the circuit and verify that the value in the Power column matches the 
value recorded in Step c, +/– 2 dB. If so, continue with Step g. If the value is lower, contact your 
next level of support.

Note If the 32DMX or 40-DMX-C/40-DMX-CE card is not carrying traffic, the values do not 
match and the verification must be skipped.

g. In node view (single-node mode) or multishelf view (multishelf mode) click the Provisioning > 
WDM-ANS > Provisioning tabs. 

h. In the Selector area, click the power on the CHAN-TX i port of 32-DMX/40-DMX-C/40-DMX-CE 
on Side A. Record the value under the Value column. If the value is not present, skip this step and 
continue with Step i.

i. Display the 32WSS or 40-WSS-C/40-WSS-CE card installed on Side A in card view.

j. Click the Provisioning > Optical Chn: Optical Connector x > Parameters where x = the MPO 
connector (1 through 4) carrying 8 wavelengths.

k. Locate the CHAN-TX port, 1 through 32 for the 32WSS card (or 1 through 40 for the 
40-WSS-C/40-WSS-CE card), that corresponds to the circuit and verify that the value in the Power 
column matches the value recorded in Step e., +/– 1 dB. If the value is lower, contact your next level 
of support.

Note If the 32WSS or 40-WSS-C/40-WSS-CE card is not carrying traffic, the values do not match 
and the above check must be skipped.

l. Repeat steps from b through k for cards that are installed on Side B. 

m. Continue with Step 13.

Step 12 If the node is a ROADM with 32WSS and 32DMX cards installed (or a ROADM with 
40-WSS-C/40-WSS-CE and 40-DMX-C/40-DMX-CE cards installed), and the circuit is a pass-through 
circuit, complete the following steps. If neither scenario applies, continue with Step 13.

a. In node view (single-node mode) or multishelf view (multishelf mode), click the Provisioning > 
WDM-ANS > Provisioning tabs.
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b. Record the power on the COM-TX port of the card on Side A. If the value is not present, skip this 
step and continue with Step c.

c. Display the 32WSS or 40-WSS-C/40-WSS-CE card installed on Side A in card view. 

d. Click the Provisioning > Optical Chn: Optical Connector x > Parameters where x = the MPO 
connector (1 through 4) carrying 8 wavelengths. For the 40-WSS-C/40-WSS-CE card, x = the MPO 
connector (1 through 5) carrying 8 wavelengths.

e. Locate the port (CHAN-TX), 33 through 64 for the 32WSS or 41 through 80 for the 
40-WSS-C/40-WSS-CE, that corresponds to the circuit and verify that the value in the Power 
column matches the value recorded in Step b, +/– 1 dB. If the value is lower, contact your next level 
of support. 

Note If the 32WSS or 40-WSS-C/40-WSS-CE card is not carrying traffic, the values do not match 
and the verification must be skipped.

f. Repeat Steps a through e or the cards installed on Side B of the node.

Step 13 Check the received power range:

a. Navigate to the node where the first TXP, MXP, or line card is installed.

b. Display the TXP, MXP, or line card in card view.

c. Complete the “DLP-G136 Clear Selected PM Counts” task on page 8-7.

d. Click the Performance > Optics PM tabs. 

e. Record the values shown in the RX Optical Pwr field. 

f. Click the Provisioning > Optics Thresholds tabs. 

g. Verify that the value in Step e falls between the values shown for the RX Power High and 
RX Power Low. If so, continue with Step 14. If not, complete one of the following. 

– Power lower than range—Clean the trunk fiber at the patch panel and on the TXP or MXP card. 
Repeat Steps e through g. If the power is still too low, contact your next level of support.

– Power higher than range—Add attenuation to the fiber and repeat Steps e through g. If the power 
still does not fall within the range, contact your next level of support.

Step 14 Perform a short-term bit error rate (BER) test:

a. Complete the “DLP-G136 Clear Selected PM Counts” task on page 8-7 for the TXP, MXP, or line 
card.

b. Display the TXP, MXP, or line card in card view.

c. Click the Performance > Payload PM tabs, or, if OTN is provisioned, the Performance > OTN PM 
tabs. 

d. Perform a short-term BER test using a test signal from a test set or protocol analyzer.

e. Monitor the payload performance monitoring (PM) for at least 10 minutes for errors.

Note To see an accurate PM count, the BER test results must be consistent with the transmitted 
bit rate for at least 10 minutes.
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Note For information about using a test set or protocol analyzer, see the test set or protocol 
analyzer user guide.

Step 15 In node view (single-node mode) or multishelf view (multishelf mode), display the next node in the 
circuit path identified in Step 8.

Step 16 Repeat Steps 9 through 14 for all nodes in the circuit path (one by one). Complete the steps for the circuit 
destination node last.

Step 17 Switch to network view and click the Circuits tab.

Step 18 Create a new OCHNC or OCHCC circuit for the next ITU wavelength listed in the Traffic Matrix report 
using one of the following tasks:

• DLP-G346 Provision Optical Channel Client Connections, page 7-4

• DLP-G105 Provision Optical Channel Network Connections, page 7-22

Step 19 After the circuit status is DISCOVERED and its state is IS, click the circuit and then click Edit.

Step 20 In the Edit Circuit dialog box, click the State tab.

Step 21 In the Cross-Connections table, verify that the circuit path is correct and record all the nodes that appear 
in the Node column. These are the nodes that are in the circuit path. The first node is the circuit source, 
and the last node is the circuit destination. If the circuit path is incorrect, delete the circuit and go back 
to Step 18 to create a new circuit.

Step 22 Complete Steps 9 through 14 for nodes in Step 21 that:

• Are not part of the circuit created in Step 4. 

• Are a circuit source or destination, and the circuit created in Step 4 did not originate or terminate on 
the same side (Side A or Side B). 

For all the remaining nodes, no further checks are needed.

Step 23 Repeat Steps 9 through 22 for all OCHCC or OCHNC circuits listed in your Traffic Matrix report. If a 
node fails any test, verify the setup and configuration and then repeat the test. If the test fails again, see 
the next level of support.

After all tests are successfully completed and no alarms exist in the network, the network is ready for 
service.

Stop. You have completed this procedure.

NTP-G56 Verify the OSNR

Purpose This procedure verifies the optical signal-to-noise ratio (OSNR). The 
OSNR is the ratio between the signal power level and the noise power level.

Tools/Equipment Optical spectrum analyzer

Prerequisite Procedures DLP-G46 Log into CTC, page 2-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at an ONS 15454 on the network.

Step 2 Using an optical spectrum analyzer, check the received OSNR for each transmitted channel on both ends 
of the span. Identify the last OSC-CSM, OPT-PRE, or OPT-BST MON port that the channel passes 
through before it is dropped. 

Note The OPT-PRE reference also applies to the OPT-AMP-17-C card operating in OPT-PRE mode 
and the OPT-BST reference also applies to the OPT-AMP-17-C card operating in OPT-LINE 
mode.

Step 3 If OPT-PRE cards are installed with an OPT-BST, OPT-BST-E, or OSC-CSM card, use the OPT-PRE 
MON port.

Note For OSNR values for each card class, see Chapter 4, “Optical Amplifier Cards.”

Step 4 If the OSNR is too low, check the following, depending on your node configuration:

Note The purpose of this step is not to improve the signal-to-noise ratio (SNR), but to match the 
per-channel power level within the RX port power range.

• Check the fiber connections between the OPT-BST, OPT-BST-E, or OSC-CSM card and the 
OPT-PRE amplifier. If needed, clean the connectors. See the “NTP-G115 Clean Fiber Connectors” 
procedure on page 13-26.

• On the near-end OPT-BST amplifier, check the equalization of the added channels at the monitor 
output.

• On the OPT-PRE amplifier, check the output power on both COM TX and DC TX ports.

• On the far-end OPT-PRE amplifier, check the amplifier gain tilt at the monitor output.

If the OSNR is still too low, contact your next level of support.

Step 5 Repeat Steps 2 and 4 for all traffic in the network.

Stop. You have completed this procedure.
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NTP-G142 Perform a Protection Switch Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at an ONS 15454 on the network.

Step 2 Identify the Y-cable circuit to be tested by viewing the Traffic Matrix for your site. Locate the TXP, 
MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP cards in the ONS 15454 node that will 
be used for the protection group.

Step 3 Verify that the Y-cable protection group is provisioned:

a. In node view (single-node mode) or multishelf view (multishelf mode), click the Provisioning > 
Protection tabs.

b. In the Protect and Working areas, confirm that the correct TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 
10GE_XPE, or OTU2_XP cards are in the Y-cable protection group by viewing the slot number and 
card type.

c. If the required protection group is not provisioned, stop and perform the “NTP-G33 Create a 
Y-Cable Protection Group” procedure on page 5-19. Otherwise, continue with Step 4.

Step 4 Repeat Step 3 for each Y-cable protection group at the node. When all protection groups are verified, 
continue with the next step.

Step 5 Physically connect the transmitter of the client or test set to either Port 10 or Port 12 of the Y-cable 
module protecting the test circuit. (See Table 3-6 on page 3-104 and Table 3-7 on page 3-104.)

Step 6 If you connected the transmitter to Port 10, connect the client or test set receiver to Port 5 on the Y-cable 
module. If not, connect the client or test set receiver to Port 11 on the Y-cable module.

Step 7 At the far-end site for the test circuit, physically loop the Y-cable module as follows:

a. If this is the first client on the Y-cable module, loop Port 10 to Port 5 on the far-end Y-cable module. 

b. If this is the second client on the Y-cable module, loop Ports 11 and 12 on the far-end Y-cable 
module.

Step 8 At the near-end site for the test circuit, place the client device or test set into service and begin 
transmitting the required payload.

Purpose This procedure tests the optical path, client TXP, MXP, GE_XP and 
GE_XPE (when provisioned in 10GE or 20GE MXP mode), 10GE_XP and 
10GE_XPE (when provisioned in 10GE TXP mode), and OTU2_XP (when 
provisioned in TXP mode) cards and the Y-cable protection groups in your 
network for proper operation. The test signals can be generated by either 
the actual client device or a test set (whichever is available). We 
recommend that you repeat this test at each node in the network where 
protection group traffic is dropped.

Tools/Equipment A list of protection groups. This information is provided in the 
Cisco Transport Planner Traffic Matrix.

A test set or actual client device that provides the required payload for the 
circuits that are provisioned.

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite; personnel are required to be on site at each end of the circuit under 
test.

Security Level Provisioning or higher
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Step 9 In CTC, display the near-end site in node view (single-node mode) or multishelf view (multishelf mode).

Step 10 Click the Maintenance > Protection tabs.

Step 11 In the Protection Groups area, highlight the protection group to be tested.

Step 12 In the Selected Group area, identify the active slot and the standby slot.

Step 13 Verify that the LED s on the physical cards in the shelf match the following:

a. For the active TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP card, record the 
slot number: _____. Verify that the port LEDs appear as follows:

– DWDM port is green.

– Client port is green.

b. For the standby TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP card, record 
the slot number: _____. Verify that the port LEDs appear as follows:

– DWDM port is green.

– Client port is not illuminated or amber, depending on the TXP, MXP, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, or OTU2_XP card.

Step 14 In the Selected Group area, highlight the active TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, 
or OTU2_XP slot.

Step 15 From the Switch Commands area below the Selected Group area, click Manual, then click YES.

Step 16 From the Selected Group area, record the following information and verify that the active and standby 
TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP slot numbers are the opposite of 
Step 13.

a. For the active TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP card, record the 
slot number: _____. Verify that the port LEDs appear as follows:

– DWDM port is green.

– Client port is green.

b. For the standby TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP card, record 
the slot number: _____. Verify that the port LEDs appear as follows:

– DWDM port is green.

– Client port is not illuminated or amber, depending on the TXP, MXP, GE_XP, 10GE_XP, 
GE_XPE, 10GE_XPE, or OTU2_XP card.

Step 17 Verify that the LEDs on the physical cards in the shelf match the following:

a. For the active TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP slot LEDs:

– DWDM port is green.

– Client port is green.

b. For the standby TXP, MXP, GE_XP, 10GE_XP, GE_XPE, 10GE_XPE, or OTU2_XP slot LEDs:

– DWDM port is green.

– Client port is not illuminated.

Step 18 Confirm that the client or test set at the local site is operating normally without alarms. If the test set is 
reporting active alarms, contact your next level of support. 

Note It is normal to see a traffic hit on the test set during a protection switch.
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Step 19 From the Switch Commands area below the Selected Group area, click Clear, then click YES to return 
the protection group to the original state.

Step 20 Repeat Steps 5 through 19 for each protection group at your site.

Stop. You have completed this procedure.

NTP-G164 Configure Link Management Protocol 

Note This procedure is normally required only when the Cisco ONS 15454 must run traffic to and from a 
Calient PXC or a Cisco CRS-1 router.

Note Cisco ONS Software Release 9.1 supports only Cisco CRS-1 router using Cisco IOS XR Software 
Release 3.9.0. If you have an earlier version of the Cisco IOS XR software, you cannot configure LMP 
on the Cisco CRS-1 router, and the router will be visible as an unknown node in the CTC network view.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 to log in to the ONS 15454 on the network.

Step 2 To enable LMP, complete the “DLP-G372 Enable LMP” task on page 6-37.

Step 3 To set up one or more control channels, complete the “DLP-G373 Create, Edit, and Delete LMP Control 
Channels” task on page 6-38.

Step 4 To set up one or more traffic engineering (TE) links, complete the “DLP-G374 Create, Edit, and Delete 
LMP TE Links” task on page 6-41.

Step 5 To set up one or more data links, complete the “DLP-G378 Create, Edit, and Delete LMP Data Links” 
task on page 6-42.

Stop. You have completed this procedure.

DLP-G372 Enable LMP

Purpose This procedure configures Link Management Protocol (LMP). LMP 
manages the channels and links that are required between nodes for 
routing, signaling, and link management.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 6-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task enables the LMP function on the ONS 15454 node.

Tools/Equipment None
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Step 1 In node view, click the Provisioning > Comm Channels > LMP > General tabs.

Step 2 In the Configuration area, click the Enable LMP check box to enable the LMP function.

Step 3 In the Local Node Id text entry box, enter the local node ID in the form of an IP address.

Note Do not set the LMP Local Node ID to another IP address in use on the network. This introduces 
a duplicate IP address in the network for traffic going to the IP address that is used as the LMP 
Local Node ID. We recommended to you set the LMP Local Node ID to the node's IP address, 
because this does not introduce a duplicate IP address in the network.

Step 4 If you are going to use LMP to manage a control channel between a Calient PXC node and a 
Cisco ONS 15454 DWDM node or between a Cisco CRS-1 router and Cisco ONS 15454 DWDM node, 
ensure that the LMP-WDM check box is unchecked.

Step 5 If you are going to use LMP to manage a control channel between the ONS 15454 nodes, check the 
LMP-WDM check box and use the Role field to choose one of the following roles:

• PEER, to use LMP to manage links between two nodes where the other node is configured as OLS. 

• OLS, to use LMP to manage links between two nodes where the other node is configured as PEER. 

The role selection is available only when LMP-WDM is enabled on the local node. Both the local and 
remote nodes must be configured with LMP-WDM enabled.

Step 6 Click Apply.

Step 7 In the Status area, verify that the Operational State is Up. This indicates that LMP is enabled and the link 
is active.

Step 8 Return to your originating procedure (NTP).

DLP-G373 Create, Edit, and Delete LMP Control Channels

Step 1 In node view, click the Provisioning > Comm Channels > LMP > Control Channels tabs.

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task creates, edits, or deletes one or more LMP control channels 
between pairs of Cisco ONS 15454 nodes, between a Calient PXC and a 
Cisco ONS 15454, or between a Cisco CRS-1 router and a Cisco ONS 
15454.

Tools/Equipment None

Prerequisite Procedures DLP-G372 Enable LMP, page 6-37

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 To create a control channel, click Create. The Create LMP Control Channel dialog box appears.

Note The values of the Admin State, Requested Hello Interval, Min Hello Interval, Max Hello 
Interval, Requested Hello Dead Interval, Min Hello Dead Interval, and Max Hello Dead Interval 
fields correspond to the values specified for these fields in the NODE > lmp section of the node 
view Provisioning > Defaults tabs. If you change the NODE > lmp values, those values are 
reflected as defaults in the Create LMP Control Channel dialog box. You can change the default 
values using the dialog box. However, the NODE > lmp values are always used as the initial 
defaults.

Step 3 In the Create LMP Control Channel dialog box, complete the following:

• Admin State—Select unlocked (if you are using an ETSI shelf) or IS (if you are using an ANSI 
shelf) to establish the control channel; otherwise, select locked, disabled (ETSI) or OOS-DSBLD 
(ANSI) to set the control channel to out of service.

• Local Port—Select Routed if the control channel is to be sent over the control plane or management 
network; otherwise, if the control channel is to be sent over the same fiber as the traffic (either in 
the payload or in the overhead), select one of the available traffic ports.

• Local Port Id—(Display only) Displays the local port identifier assigned by the node.

• Remote Node Type—Select 15454 or non-CRS1 if you are creating a control channel between two 
Cisco ONS 15454 nodes or between a Calient PXC and a Cisco ONS 15454 node; otherwise, select 
CRS-1 if you are creating a control channel between a Cisco CRS-1 router and a Cisco ONS 15454 
node.

• Remote Node Address—In dotted-decimal format, enter the number that identifies the IP address of 
the remote node (either a Calient PXC peer node, a Cisco CRS-1 router, or a Cisco ONS 15454 
node) where the control channel will be established.

• Remote Node ID—Initially, CTC autopopulates this value to the remote node IP address that you 
just assigned. However, you can change the identifier to any nonzero 32-bit integer in dotted decimal 
format (for example, 10.92.29.10).

• Requested Hello Interval—Enter the Requested Hello Interval in milliseconds (ms). Before sending 
Hello messages, the Hello Interval and Hello Dead Interval parameters must be established by the 
local and remote nodes. These parameters are exchanged in the Config message. The Hello Interval 
indicates how frequently LMP Hello messages will be sent; the interval must be in the 300 ms to 
5000 ms range. The Min Hello Interval must be less than or equal to the Requested Hello Interval, 
and the Requested Hello Interval must be less than or equal to the Max Hello Interval.

• Min Hello Interval—Enter the minimum Hello Interval in milliseconds. When the two nodes 
negotiate for the Hello Interval, the value that you enter here will be the minimum Hello Interval 
acceptable for the local node. The Min Hello Interval must be in the 300 ms to 5000 ms range. The 
Min Hello Interval must be less than or equal to the Requested Hello Interval and the Requested 
Hello Interval must be less than or equal to the Max Hello Interval.

• Max Hello Interval—Enter the maximum Hello Interval in milliseconds. When the two nodes 
negotiate for the Hello Interval, the value that you enter here will be the maximum Hello Interval 
acceptable for the local node. The Max Hello Interval must be in the 300 ms to 5000 ms range. The 
Min Hello Interval must be less than or equal to the Requested Hello Interval and the Requested 
Hello Interval must be less than or equal to the Max Hello Interval.

• Requested Hello Dead Interval—Enter the Requested Hello Dead Interval in milliseconds. The 
Requested Hello Dead Interval indicates how long a device should wait to receive a Hello message 
before declaring a control channel dead. The Requested Hello Dead interval must be in the 2000 ms 
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to 20000 ms range. The Min Hello Dead Interval must be less than or equal to the Requested Hello 
Dead Interval and the Requested Hello Dead Interval must be less than or equal to the Max Hello 
Dead Interval.

Note The Requested Hello Dead Interval must be at least three times greater than the Requested 
Hello Interval.

• Min Hello Dead Interval—Enter the minimum Hello Dead Interval in milliseconds. The minimum 
Hello Dead Interval must be in the 2000 ms to 20000 ms range. The minimum Hello Dead Interval 
must be less than or equal to the Requested Hello Dead Interval and the Requested Hello Dead 
Interval must be less than or equal to the Max Hello Dead Interval. When the two nodes negotiate 
for the Hello Dead Interval, the value that you enter here will be the minimum Hello Dead Interval 
acceptable for the local node. 

Note The value of the Min Hello Dead Interval must be greater than the Min Hello Interval.

• Max Hello Dead Interval—Enter the maximum Hello Dead Interval in milliseconds. This interval 
must be in the 2000 ms to 20000 ms range. The Min Hello Dead Interval must be less than or equal 
to the Requested Hello Dead Interval and the Requested Hello Dead Interval must be less than or 
equal to the Max Hello Dead Interval. When the two nodes negotiate for the Hello Dead Interval, 
the value that you enter here will be the maximum Hello Dead Interval acceptable for the local node. 

Note The Max Hello Dead Interval must be greater than the Max Hello Interval.

Step 4 Click OK to accept the parameters that you have entered, or click Cancel to return to the Control 
Channels tab without creating a control channel.

Step 5 If you have chosen the Remote Node Type as CRS-1 in Step 3 and if you have chosen that automatic 
LMP configuration in the “DLP-G508 Configure the Cisco CRS-1 Router Parameters” task on 
page 6-46, a confirmation dialog box is displayed to indicate that this operation will also change the 
configuration of the Cisco CRS-1 router. Click Yes.

Step 6 If you created a control channel, verify that the parameters for the new Control Channel appear properly 
in the Control Channels tab.

Note The Actual Hello Interval and Actual Hello Dead Interval parameters reflect the values of these 
parameters as a result of the negotiated agreement of the local and remote nodes. They may be 
different than the requested values.

Step 7 After the LMP control channel has been created, observe the status of the channel in the Operational 
State column of the Control Channels tab, and take the appropriate action as shown in the following list:

• Up—The control channel contacted the far-end node and successfully negotiated a control channel.

• Down—LMP is enabled and the link is inactive. Ensure that the Admin State of the control channel 
is unlocked (ETSI) or IS (ANSI) and not disabled (ETSI) or OOS-DSBLD (ANSI). If the state still 
does not transition to Up, the far-end control channel might have disjointed Hello negotiation times 
that prevent a control channel from transitioning to the Up state. For example, the local ONS 15454 
Min Hello Interval and Max Hello Interval might be 900 to 1000, while the remote Min Hello 
Interval and Max Hello Interval is 1100 to 1200.
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• Config Send—The connection could not be made to the remote node. Check to make sure that the 
remote node address and remote node ID addresses are correct.

• Config Received—The local node sent a configuration request to the remote node and received a 
response of either ConfigNack or ConfigAck.

• Unknown

Step 8 To delete a control channel, click the channel row to highlight it and click Delete. A confirmation dialog 
box appears that allows you to click OK or Cancel.

Step 9 To edit a control channel, click the channel row to highlight it and click Edit. A dialog box appears that 
allows you to change the control channel parameters. You can then click OK or Cancel. If you are 
editing a control channel that involves a Cisco CRS-1 router, a confirmation dialog box is displayed. 
Click Yes.

Step 10 Return to your originating procedure (NTP).

DLP-G374 Create, Edit, and Delete LMP TE Links

Step 1 In node view, click the Provisioning > Comm Channels > LMP > TE Links tabs.

Step 2 To create a TE link, click Create. The Create LMP TE Link dialog box appears.

Step 3 In the Create LMP TE Link dialog box, complete the following:

• Admin State—Select unlocked (for ETSI shelves) or IS (for ANSI shelves) to put the TE link in 
service; otherwise, select locked, disabled (ETSI) or OOS-DSBLD (ANSI) to set the TE link to out 
of service.

• Remote Node Id—Select a remote node (either a Calient PXC peer node, a Cisco CRS-1 router, or 
a Cisco ONS 15454 node) for the other end of the TE link.

• Remote TE Link Id—Enter an unsigned 32-bit value (such as 0x00000001) to identify the remote 
node identifier for the other end of the TE link. This option is not available if you have chosen the 
automatic LMP configuration in “DLP-G508 Configure the Cisco CRS-1 Router Parameters” task 
on page 6-46.

• MUX Capability—Select the MUX capability. This option is not available if you are creating a TE 
link that involves a Cisco CRS-1 router.

Step 4 Click OK to accept the parameters that you have entered and create the TE link, or click Cancel to return 
to the Control Channels tab without creating a TE link.

Step 5 If you created a TE link, verify that the parameters for the new TE link now appear properly in the TE 
Links tab.

Purpose This task creates, edits, or deletes TE links and their association to 
neighboring LMP nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G372 Enable LMP, page 6-37

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 After the TE link has been created, observe the status of the TE link in the Operational State column of 
the TE Links pane, and take the appropriate action as shown in the following list:

• Up—The TE link is active.

• Down—Ensure that the Admin State of the TE link is unlocked (ETSI) or IS (ANSI) and not 
disabled (ETSI) or OOS-DSBLD (ANSI). The TE link does not transition to the Up state until a data 
link has been provisioned.

• Init—Verify that the Remote Node ID and Remote TE Link ID values are correct for the remote 
node. Verify that the remote node is using the Cisco ONS 15454 or the Cisco CRS-1 router IP 
address for its remote node IP and that the remote node is using the local TE link index for its remote 
TE link index.

Step 7 To delete a TE link, click the link row to highlight it and click Delete. A confirmation dialog box appears 
that allows you to click OK or Cancel.

Step 8 To edit a TE link, click the link row to highlight it and click Edit. A dialog box appears that allows you 
to change the TE link parameters. You can then click OK or Cancel.

Step 9 Return to your originating procedure (NTP).

DLP-G378 Create, Edit, and Delete LMP Data Links

Note A port cannot be deleted if it is being used by a data link. A card cannot be deleted if any of its ports are 
being used by data links. Changing the state of the port impacts the state of a data link using the port.

Step 1 In node view, click the Provisioning > Comm Channels > LMP > Data Links tabs.

Step 2 To create a data link, click Create. The Create LMP Data Link dialog box appears.

Step 3 In the Create LMP Data Link dialog box, complete the following:

• Local Port—Select one of the available local ports for the data link.

• Local Port Id—(Display only) Displays the local port identifier.

• Data Link Type—Select Port or Component. A data link is considered to be either a port or a 
component link on each node where it terminates, depending on the multiplexing capability of the 
endpoint on that link; component links are multiplex capable, whereas ports are not multiplex 
capable.

• Local TE Link Id—Select an identifier for one of the local TE links that has already been created.

Purpose This task creates, edits, or deletes one or more data links, which define the 
node’s transport parameters. CTC supports up to 256 LMP data links.

Tools/Equipment None

Prerequisite Procedures NTP-G54 Provision and Verify a DWDM Network, page 6-28

DLP-G372 Enable LMP, page 6-37

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Remote CRS Port Id—Select one of the available remote Cisco CRS-1 ports for the data link. This 
option is not available if you are creating a data link between two Cisco ONS 15454 nodes.

• Remote Port Id—Enter an unsigned 32-bit value (such as 0x00000001) to identify the remote node 
identifier for the other end of the data link. This option is not available if you have chosen the 
automatic LMP configuration in the “DLP-G508 Configure the Cisco CRS-1 Router Parameters” 
task on page 6-46.

Step 4 Click OK to accept the parameters you have entered and create the data link, or click Cancel to return 
to the Data Links tab without creating a data link.

Step 5 If you are creating a data link that involves a Cisco CRS-1 router and if you have chosen the automatic 
LMP configuration in the “DLP-G508 Configure the Cisco CRS-1 Router Parameters” task on 
page 6-46, a confirmation dialog box is displayed to indicate that this operation will also change the 
configuration of the Cisco CRS-1 router. Click Yes.

Step 6 If you created a data link, verify that the parameters for the new data link now appear properly in the 
Data Links tab.

Step 7 After the data link has been created, observe its status in the Operational State column of the Data Links 
tab, and take the appropriate action as shown in the following list:

• Up–Alloc or Up–Free—If the data link state does not transition to Up–Alloc or Up–Free, verify that 
the port is in service. Verification must be done using the CTC card view > Provisioning tab for the 
cards. (The difference between Up–Alloc and Up–Free is that an Up–Alloc data link is allocated for 
data traffic. An Up–Free data link is not allocated for traffic. The far end is either not ready to receive 
traffic through this port, or the path is being used as a backup in case some other allocated data link 
goes down).

• Down—The data link will be in the Down state if the port is not unlocked or not in-service. Verify 
that the remote port ID for the far-end data link is correct. On the far end, verify that the data link 
is using the local port ID as its remote port ID.

Step 8 To delete a data link, click the data link row to highlight it and click Delete. A confirmation dialog box 
appears that allows you to click OK or Cancel.

Step 9 To edit a data link, click the data link row to highlight it and click Edit. A dialog box appears that allows 
you to change the data link parameters. You can then click OK or Cancel. If you are editing a data link 
that involves a Cisco CRS-1 router, a confirmation dialog box is displayed. Click Yes.

Step 10 Return to your originating procedure (NTP).
6-43
Cisco ONS 15454 DWDM Procedure Guide, R9.1

78-18886-02



 

Chapter 6      Turn Up a Network
Before You Begin
NTP-G233 Configure Link Management Protocol on the Cisco 
CRS-1 Router and the Cisco ONS 15454 DWDM Node

Note This procedure is normally required only when the Cisco ONS 15454 DWDM node must run traffic to 
and from a Cisco CRS-1 router.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 to log in to a DWDM node on the network.

Step 2 Complete the “DLP-G508 Configure the Cisco CRS-1 Router Parameters” task on page 6-46 to 
configure the CRS-router parameters. 

Step 3 Complete the “DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and Verify 
Configuration” task on page 6-47 to establish a Telnet session with the Cisco CRS-1 router.

Step 4 Complete the “DLP-G510 Create a Task Group, User Group, and User Account on the Cisco CRS-1 
Router” task on page 6-48 to create task groups, user groups, and user accounts on the Cisco CRS-1 
router.

Step 5 If you have chosen the automatic LMP configuration in Step 2, complete the “NTP-G234 Automatically 
Configure Link Management Protocol on the Cisco CRS-1 Router and the Cisco ONS 15454 DWDM 
Node” procedure on page 6-44. 

If you have chosen the manual LMP configuration in Step 2, complete the “NTP-G207 Manually 
Configure Link Management Protocol on the Cisco CRS-1 Router and the Cisco ONS 15454 DWDM 
Node” procedure on page 6-45.

Stop. You have completed this procedure.

NTP-G234 Automatically Configure Link Management Protocol 
on the Cisco CRS-1 Router and the Cisco ONS 15454 DWDM 
Node

Purpose This procedure configures LMP on the Cisco ONS 15454 DWDM node and 
on the corresponding Cisco CRS-1 physical layer interface module (PLIM) 
port.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 6-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure automatically configures LMP on the Cisco ONS 15454 
DWDM node and on the corresponding Cisco CRS-1 PLIM port.

Tools/Equipment None
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Step 1 Complete the “DLP-G372 Enable LMP” task on page 6-37 to enable the LMP function on the DWDM 
node.

Step 2 Complete the “DLP-G373 Create, Edit, and Delete LMP Control Channels” task on page 6-38 to create 
the LMP control channel between the Cisco CRS-1 router and the DWDM node.

Step 3 Complete the “DLP-G374 Create, Edit, and Delete LMP TE Links” task on page 6-41 to create TE links 
between the Cisco CRS-1 router and the DWDM node.

Step 4 Complete the “DLP-G378 Create, Edit, and Delete LMP Data Links” task on page 6-42 to create a data 
link, which define the node’s transport parameters.

Stop. You have completed this procedure.

NTP-G207 Manually Configure Link Management Protocol on 
the Cisco CRS-1 Router and the Cisco ONS 15454 DWDM Node

Note For more information about the Cisco IOS XR commands used in the DLPs, see the Cisco IOS XR 
Command Reference publication at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Step 1 Complete the “DLP-G372 Enable LMP” task on page 6-37 to enable the LMP function on the DWDM 
node.

Step 2 Complete the “DLP-G373 Create, Edit, and Delete LMP Control Channels” task on page 6-38 to create 
the LMP control channel between the Cisco CRS-1 router and the DWDM node.

Step 3 Complete the “DLP-G374 Create, Edit, and Delete LMP TE Links” task on page 6-41 to create TE links 
between the Cisco CRS-1 router and the DWDM node.

Step 4 In node view, click the Provisioning > Comm Channels > LMP > TE Links tab and write down the 
value of the Local TE Link field so that it can be used later.

Prerequisite Procedures NTP-G233 Configure Link Management Protocol on the Cisco CRS-1 
Router and the Cisco ONS 15454 DWDM Node, page 6-44

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure manually configures LMP on the Cisco ONS 15454 
DWDM node and on the corresponding Cisco CRS-1 PLIM port.

Tools/Equipment None

Prerequisite Procedures NTP-G233 Configure Link Management Protocol on the Cisco CRS-1 
Router and the Cisco ONS 15454 DWDM Node, page 6-44

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Complete the “DLP-G378 Create, Edit, and Delete LMP Data Links” task on page 6-42 to create a data 
link, which define the node’s transport parameters.

Step 6 In node view, click the Provisioning > Comm Channels > LMP > Data Links tab and write down the 
value of the Local Port Id field so that it can be used later.

Step 7 Complete the “DLP-G482 Configure a Static Route” task on page 6-51 to configure a static route.

Step 8 Complete the “DLP-G483 Configure Local and Remote TE Links” task on page 6-52 to configure the 
local and remote TE links.

Step 9 Complete the “DLP-G484 Enable the LMP Message Exchange” task on page 6-54 to enable LMP 
message exchange with the LMP neighbor.

Step 10 In node view, click the Provisioning > Comm Channels > LMP > Data Links tab and from the Local 
Port field, write down the card and the port involved in the LMP link. Double-click the card involved in 
the LMP link. In card view, click the Provisioning > Optical Chn > Parameters tabs and write down 
the value of the Actual Wavelength field for the port involved in the LMP link.

Step 11 Complete the “DLP-G511 Configure the Wavelength on the Cisco CRS-1 Router” task on page 6-55 to 
configure the wavelength on the PLIM port of the Cisco CRS-1 router.

Step 12 If you need RADIUS AAA services, complete the “DLP-G494 Configure the RADIUS Server” task on 
page 6-57 to configure a RADIUS server.

Step 13 Complete the “DLP-G485 Enable Index Persistency on an SNMP Interface” task on page 6-58 to enable 
index persistency on an SNMP interface.

Step 14 Complete the “DLP-G486 Configure the LMP Router ID” task on page 6-59 to configure LMP router ID.

Step 15 Complete the “DLP-G487 Configure the 10 Gigabit Ethernet (GE) or POS Interface” task on page 6-60 
to configure an interface and specify the IPv4 address for the interface.

Note Only users with proper task privileges, or a system administrator, can perform DLP-G482, 
DLP-G483, DLP-G484, DLP-G494, DLP-G485, and DLP-G486. The task privileges required to 
perform these DLPs are similar to the privileges required for automatic LMP configuration. 

Step 16 Complete the “DLP-G488 Display Summary of Link Management Information” task on page 6-61 to 
display the interface resource or a summary of link management information.

Step 17 Complete the “DLP-G374 Create, Edit, and Delete LMP TE Links” task on page 6-41 to edit the TE link 
created in Step 3. Change the Remote TE Link ID value to the value (Local TE Link ID) noted in Step 1 
of the “DLP-G488 Display Summary of Link Management Information” task on page 6-61.

Step 18 Complete the “DLP-G378 Create, Edit, and Delete LMP Data Links” task on page 6-42 to edit the data 
link created in Step 5. Change the Remote Port Id value to the value (Local Data Link ID) noted in Step 1 
of the “DLP-G488 Display Summary of Link Management Information” task on page 6-61.

Stop. You have completed this procedure.

DLP-G508 Configure the Cisco CRS-1 Router Parameters

Purpose This task configures the Cisco CRS-1 router.

Tools/Equipment None
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Step 1 In any CTC view, from the Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the Router tab.

Step 3 Skip automatic LMP configuration on routers—Leave this option unchecked if you want CTC to 
automatically configure an interface on the Cisco CRS-1 router for the data link. If you check this option, 
you must manually perform the interface configuration on the Cisco CRS-1 router.

Step 4 In the Router login area, enter the following:

• Username—Specify the name of the user on the Cisco CRS-1 router. 

• Password—Specify the user password.

• Confirm Password—Specify the password again to confirm it.

Note If you leave the Username and Password fields blank, the CTC login information (username and 
password) will be used for the Cisco CRS-1 router. 

Step 5 Click OK.

Step 6 Return to your originating procedure (NTP).

DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and Verify 
Configuration

Prerequisite Procedures NTP-G54 Provision and Verify a DWDM Network, page 6-28

DLP-G372 Enable LMP, page 6-37

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task establishes a Telnet session with the Cisco CRS-1 router and 
verifies the node configuration, SSH, and/or XML module configuration.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G510 Create a Task Group, User Group, and User Account on the Cisco 
CRS-1 Router

Note Only users who have permission to create new task groups and configure required task privileges, or a 
system administrator, can perform this task.

Command or Action Purpose

Step 1 telnet {ip-address | host-name}

Example:
router# telnet 10.58.41.169

Establishes a Telnet session with the Cisco CRS-1 router. When the 
session is established, you can log in with the root-system username 
and password. After you log in, the router displays the CLI prompt for 
the Cisco IOS XR software.

Step 2 show install active summary

Example:
router# show install active summary

Displays a summary of the active packages in a system or secure 
domain router. Ensure that the output of the show install active 
summary command includes the following lines:

hfr-mpls-3.9.x
hfr-k9sec-3.9.x
hfr-mgbl-3.9.x

Step 3 show running-config

Example:
router# show running-config

Displays the contents of the currently running configuration and 
verifies that Extensible Markup Language (XML) agent service and 
Secure Shell (SSH) client are installed on the Cisco CRS-1 router. 
Ensure that the output of the show running-config command 
includes the following lines:

ssh server v2
ssh server session-limit sessions
ssh server rate-limit maxsessions_per_minute
vty-pool default first-vty last-vty line-template default
xml agent tty

If the output does not contain the above lines, check the SSH and/or 
XML module configuration. Refer to Cisco IOS XR System Security 
Command Reference and Cisco IOS XR System Management 
Command Reference for details about SSH and XML configuration.

Step 4 Return to your originating procedure (NTP). —

Purpose This task creates task groups, user groups, and user accounts on the Cisco 
CRS-1 router.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 taskgroup taskgroup-name

Example:
router# taskgroup ipodwdmop

Creates a new task group and enters task group configuration 
submode. 

If you have chosen the automatic LMP configuration in the 
“DLP-G508 Configure the Cisco CRS-1 Router Parameters” task on 
page 6-46, perform Step 3. If you have chosen the manual LMP 
configuration in the “DLP-G508 Configure the Cisco CRS-1 Router 
Parameters” task on page 6-46, perform Step 4.

Step 3 task {read | write | execute | debug} 
taskid-name

Example:
router(config-tg)# task read cef

Specifies a task ID to be associated with the task group named in 
Step 2. Task IDs grant permission to perform certain tasks. 

Ensure that you specify the following task IDs to set up required 
privileges for the automatic LMP configuration:

task read cef
task read dwdm
task read ouni
task read snmp
task read static
task read sysmgr
task read logging
task read mpls-te
task read network
task read interface
task read basic-services
task write dwdm
task write ipv4
task write ouni
task write snmp
task write static
task write mpls-te
task write network
task write interface

Step 4 task {read | write | execute | debug} 
taskid-name

Example:
router(config-tg)# task read cef

Specifies a task ID to be associated with the task group named in 
Step 2. Task IDs grant permission to perform certain tasks. 

Ensure that you specify the following task IDs to set up required 
privileges for the manual LMP configuration:

task read cef
task read dwdm
task read ouni
task read snmp
task read static
task read sysmgr
task read logging
task read mpls-te
task read network
task read interface
task read basic-services
task write interface
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Step 5 end

Example:
router(config-tg)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to commit 
the changes. Enter yes to save the configuration changes to the 
running configuration file and return to the EXEC mode.

Step 6 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 7 usergroup usergroup-name

Example:
router# usergroup ipodwdmop

Creates a new user group and enters user group configuration 
submode.

Step 8 taskgroup taskgroup-name

Example:
router(config-ug)# taskgroup ipodwdmop

Associates the user group named in Step 7 with the task group named 
in this step. The user group takes on the configuration attributes (task 
ID list and permissions) already defined for the entered task group. 

Step 9 end

Example:
router(config-ug)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to commit 
the changes. Enter yes to save the configuration changes to the 
running configuration file and return to the EXEC mode.

Step 10 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 11 username user-name

Example:
router# username user123

Creates a name for a new user (or identifies a current user) and enters 
username configuration submode. The user-name argument can be 
only one word. Spaces and quotation marks are not allowed. 

Note The user that you specify for this command must be the user 
you have specified in the “DLP-G508 Configure the Cisco 
CRS-1 Router Parameters” task on page 6-46.

Step 12 password {0 | 7} password 

Example:
router(config-un)# password 0 passwd

Specifies a password for the user named in Step 11. Entering 0 
following the password command specifies that an unencrypted 
(clear-text) password follows. Entering 7 following the password 
command specifies that an encrypted password follows. 

Step 13 group group-name

Example:
router(config-un)# group ipodwdmop

Assigns the user named in Step 11 to a user group that has already 
been defined through the usergroup command in Step 7.

• The user takes on all attributes of the user group, as defined by 
that user group's association to various task groups.

• Each user must be assigned to at least one user group. A user may 
belong to multiple user groups. 

Command or Action Purpose
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DLP-G482 Configure a Static Route

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note In the examples shown in this task, the IP address of the DWDM node is 10.58.41.22 and the IP address 
of the Cisco CRS-1 router is 10.58.41.169. To remove the static route configuration, use the no form of 
the Cisco IOS XR command. For more information about the Cisco IOS XR commands, see the 
Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Step 14 end

Example:
router(config-ug)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to commit 
the changes. Enter yes to save the configuration changes to the 
running configuration file and return to the EXEC mode.

Step 15 Return to your originating procedure (NTP). —

Purpose This task explains how to configure a static route.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and 
Verify Configuration, page 6-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 router static

Example:
router(config)# router static

Enters static router configuration mode.

Step 3 address-family ipv4 unicast

Example:
router(config-static)# address-family ipv4 
unicast

Enters address family configuration mode while configuring static 
routes.
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DLP-G483 Configure Local and Remote TE Links

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note In the examples shown in this task, the IP address of the DWDM node is 10.58.41.22 and the IP address 
of the Cisco CRS-1 router is 10.58.41.169. To remove the local and remote TE link configuration, use 
the no form of the Cisco IOS XR command. For more information about the Cisco IOS XR commands, 
see the Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Step 4 destination-prefix prefix-mask {ip-address 
| interface-type interface-instance}

Example:
router(config-static-afi)# 10.58.41.22/32 
MgmtEth 0/RP0/CPU0/0

Establishes static routes in address family configuration mode. 
Specify the following options for this command:

• destination-prefix—IP route prefix for the destination (that is, 
DWDM node involved in the LMP link).

• prefix-mask—Prefix mask for the destination. The network 
mask can be specified as either a four-part, dotted-decimal 
address or can be indicated as a slash (/) and number.

• ip-address—(Optional) IP address of the next hop that can be 
used to reach that network. The IP address is required, not 
optional, if the interface type and number are not specified. 
You can specify an IP address and an interface type and 
interface number. 

• interface-type—(Optional) Interface type.

• interface-instance—(Optional) Either a physical interface 
instance or a virtual interface instance.

Note The interface that you specify for this command must be 
the management interface that connects the CRS-router to 
the DWDM node.

Step 5 end

Example:
router(config-static-afi)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 6 Return to your originating procedure (NTP). —

Purpose This task explains how to configure the local and remote TE links.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and 
Verify Configuration, page 6-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose
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Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 mpls traffic-eng interface interface-type 
interface-instance

Example:
router(config)# mpls traffic-eng interface 
TenGigE 0/1/0/1

Enables Multiprotocol Label Switching-Traffic Engineering 
(MPLS-TE) on an interface and enters MPLS-TE interface 
submode.

Note The interface that you specify for this command must be 
the optical interface related to the PLIM port involved in 
the LMP link.

Step 3 lmp data-link adjacency

Example:
router(config-mpls-te-if)# lmp data-link 
adjacency

Enters the LMP neighbor adjacency configuration mode.

Step 4 neighbor neighbor-name

Example:
router(config-mpls-ouni-if-adj)# neighbor 
10.58.41.22

Associates an interface with a given LMP neighbor.

Step 5 remote te-link-id unnum identifier

Example:
router(config-mpls-te-if-adj)# remote 
te-link-id unnum 1

Configures the LMP neighbor remote TE link ID.

Note Specify the value (converted to decimal format) noted in 
Step 4 of “NTP-G207 Manually Configure Link 
Management Protocol on the Cisco CRS-1 Router and the 
Cisco ONS 15454 DWDM Node” procedure on page 6-45 
for the te-link-id unnum identifier keywords and 
argument.

Step 6 remote interface-id unnum identifier

Example:
router(config-mpls-te-if-adj)# remote 
interface-id unnum 57410

Configures the LMP neighbor remote interface identifier.

Note Specify the value (converted to decimal format) noted in 
Step 6 of “NTP-G207 Manually Configure Link 
Management Protocol on the Cisco CRS-1 Router and the 
Cisco ONS 15454 DWDM Node” procedure on page 6-45 
for the interface-id unnum identifier keywords and 
argument.

Step 7 remote switching-capability fsc

Example:
router(config-mpls-te-if-adj)# remote 
switching-capability fsc

Configures the LMP neighbor remote TE interface switching 
capability.

Step 8 end

Example:
router(config-mpls-te-if-adj)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 9 Return to your originating procedure (NTP). —
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DLP-G484 Enable the LMP Message Exchange

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note In the examples shown in this task, the IP address of the DWDM node is 10.58.41.22 and the IP address 
of the Cisco CRS-1 router is 10.58.41.169. To remove the LMP message exchange configuration, use the 
no form of the Cisco IOS XR command. For more information about the Cisco IOS XR commands, see 
the Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Purpose This task explains how to enable the LMP message exchange with the LMP 
neighbor.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and 
Verify Configuration, page 6-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 mpls traffic-eng signalling advertise 
explicit-null

Example:
router(config)# mpls traffic-eng 
signalling advertise explicit-null

Specifies that tunnels terminating on a router use explicit-null 
labels.

Step 3 mpls traffic-eng lmp neighbor 
neighbor-name

Example:
router(config)# mpls traffic-eng lmp 
neighbor 10.58.41.22

Configures or updates a new or existing LMP neighbor. 

Step 4 ipcc routed

Example:
router(config-mpls-te-nbr-10.58.41.22)# 
ipcc routed

Configures a routed Internet Protocol Control Channel (IPCC) for 
the LMP neighbor.
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DLP-G511 Configure the Wavelength on the Cisco CRS-1 Router

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note To remove the wavelength setting, use the no form of the Cisco IOS XR command. For more information 
about the Cisco IOS XR commands, see the Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Step 5 remote node-id ip-address

Example:
router(config-mpls-te-nbr-10.58.41.22)# 
remote node-id 10.58.41.22

Configures the remote node ID for the LMP neighbor (DWDM 
node).

Step 6 end

Example:
router(config-mpls-te-nbr-10.58.41.22)# 
end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 7 Return to your originating procedure (NTP). —

Purpose This task explains how to configure the wavelength on the PLIM port of 
the Cisco CRS-1 router.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and 
Verify Configuration, page 6-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose
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Command or Action Purpose

Step 1 show controllers dwdm interface-instance 
wavelength-map

Example:
router# show controllers dwdm 0/1/0/0 
wavelength-map

Displays the wavelength information of an interface.

Note The interface that you specify for this command must be 
the optical interface related to the PLIM port involved in 
the LMP link.

The output of the show command will include the following lines:

Wavelength band: C-band
MSA ITU channel range supported: 3~84

03       196.00          1529.553
----------------------------------------
04       195.95          1529.944
----------------------------------------
05       195.90          1530.334
----------------------------------------
06       195.85          1530.725
----------------------------------------

From the output of the show command, write down the channel 
number of the wavelength that matches that of the wavelength 
noted in Step 10 of “NTP-G207 Manually Configure Link 
Management Protocol on the Cisco CRS-1 Router and the Cisco 
ONS 15454 DWDM Node” procedure on page 6-45.

Step 2 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 3 controller dwdm interface-instance

Example:
router(config)# controller dwdm 0/1/0/0

Configures the DWDM controller.

Note The interface that you specify for this command must be 
the optical interface related to the PLIM port involved in 
the LMP link.

Step 4 wavelength channel-number

Example:
router(config)# wavelength 04

Configures a specific wavelength to the DWDM controller. 

Note The channel number that you specify for this command 
must be the value noted down in Step 1.

Step 5 end

Example:
router(config-mpls-te-nbr-10.58.41.22)# 
end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 6 Return to your originating procedure (NTP). —
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DLP-G494 Configure the RADIUS Server

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note In the examples shown in this task, the IP address of the RADIUS server is 10.58.39.57. To remove the 
RADIUS server configuration, use the no form of the Cisco IOS XR command. For more information 
about the Cisco IOS XR commands, see the Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Purpose This task explains how to configure the RADIUS server.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and 
Verify Configuration, page 6-47

For details on configuring a node for RADIUS authentication, see the 
DLP-G281 Configure the Node for RADIUS Authentication, page 10-64. 
See the User Guide for Cisco Secure ACS for Windows Server for more 
information about configuring the RADIUS server.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 radius-server host ip-address [auth-port 
port-number] [acct-port port-number] [key 
string] 

Example:
router(config)# radius-server host 
10.58.39.57 auth-port 1812 acct-port 1813  
key 7 12485043475F

Specifies the RADIUS server host.

Step 3 aaa group server radius group-name

Example:
router(config)# aaa group server radius 
radgroup1

Groups different RADIUS server hosts into distinct lists and 
enters server group configuration mode.
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DLP-G485 Enable Index Persistency on an SNMP Interface

Note Only users with proper task privileges, or a system administrator, can perform this task.

Step 4 server ip-address [auth-port port-number] 
[acct-port port-number]

Example:
router(config-sg-radius)# server 
10.58.39.57 auth-port 1812 acct-port 1813

Associates a particular RADIUS server with a defined server 
group.

Step 5 end

Example:
router(config-sg-radius)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 6 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 7 aaa authentication login {{console | 
default} {group group_name | local | 
none}} 

Example:
router(config)# aaa authentication login 
default group radgroup1 local

Configures the authentication method used for login to the Virtual 
Firewall (VFW) application CLI. 

Step 8 end

Example:
router(config-if)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 9 Return to your originating procedure (NTP). —

Purpose This task explains how to enable index persistency on a Simple Network 
Management Protocol (SNMP) interface.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and 
Verify Configuration, page 6-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Command or Action Purpose
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Note To remove the index persistency configuration, use the no form of the Cisco IOS XR command. For 
more information about the Cisco IOS XR commands, see the Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

DLP-G486 Configure the LMP Router ID

Note Only users with proper task privileges, or a system administrator, can perform this task.

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 snmp-server interface interface-type 
interface-instance

Example:
router(config)# snmp-server interface 
TenGigE 0/1/0/1

Enables an interface to send SNMP trap notifications and enters 
SNMP interface configuration mode.

Note The interface that you specify for this command must be 
the optical interface related to the PLIM port involved in 
the LMP link.

Step 3 index persistence

Example:
router(config-snmp-if)# index persistence

Enables index persistency on an SNMP interface. This command 
must be performed to ensure that the LMP IDs are persistent even 
after a system reload.

Step 4 end

Example:
router(config-snmp-if)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 5 Return to your originating procedure (NTP). —

Purpose This task explains how to configure the LMP router ID.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and 
Verify Configuration, page 6-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note In the examples shown in this task, the IP address of the DWDM node is 10.58.41.22 and the IP address 
of the Cisco CRS-1 router is 10.58.41.169. To remove the LMP router ID configuration, use the no form 
of the Cisco IOS XR command. For more information about the Cisco IOS XR commands, see the 
Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

DLP-G487 Configure the 10 Gigabit Ethernet (GE) or POS Interface

Note Only users with proper task privileges, or a system administrator, can perform this task.

Note To remove the POS interface configuration, use the no form of the Cisco IOS XR command. For more 
information about the Cisco IOS XR commands, see the Cisco IOS XR Command Reference at 
http://www.cisco.com/en/US/products/ps5845/products_product_indices_list.html.

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 mpls traffic-eng lmp router-id ip-address

Example:
router(config)# mpls traffic-eng lmp 
router-id 10.58.41.169

Configures the LMP router ID.

Step 3 end

Example:
router(config)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 4 Return to your originating procedure (NTP). —

Purpose This task explains how to configure the 10 GE or POS interface.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and 
Verify Configuration, page 6-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G488 Display Summary of Link Management Information

Command or Action Purpose

Step 1 configure terminal

Example:
router# configure terminal

Enters global configuration mode.

Step 2 interface interface-type 
interface-instance

Example:
router(config)# interface TenGigE 0/1/0/1

Enters interface configuration mode.

Note The interface that you specify for this command must be 
the optical interface related to the PLIM port involved in 
the LMP link.

Step 3 ipv4 point-to-point

Example:
router(config-if)# ipv4 point-to-point

Configures a 10 GE interface to act as a point-to-point interface.

Note For a POS interface, skip this step and continue with 
Step 4.

Step 4 ipv4 unnumbered interface-type 
interface-instance

Example:
router(config-if)# ipv4 unnumbered MgmtEth 
0/RP0/CPU0/0

Specifies the MPLS-TE tunnel IPv4 address for the interface.

Note The interface that you specify for this command must be 
the management interface that connects the CRS-router to 
the DWDM node.

Step 5 end

Example:
router(config-if)# end

Saves configuration changes. 

When you enter the end command, the system prompts you to 
commit the changes. Enter yes to save the configuration changes 
to the running configuration file and return to the EXEC mode.

Step 6 Return to your originating procedure (NTP). —

Purpose This task displays the interface resource or a summary of link management 
information.

Tools/Equipment None

Prerequisite Procedures DLP-G481 Establish Telnet Session with the Cisco CRS-1 Router and 
Verify Configuration, page 6-47

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G57 Create a Logical Network Map

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 at a node on the network where you want to 
create the network map. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View. 

Step 3 Change the position of the nodes in the network view according to your site plan:

a. Click a node to select it, then drag and drop the node icon to a new location. 

b. Repeat Step a for each node that you need to position.

Step 4 On the network view map, right-click and choose Save Node Position from the shortcut menu.

Step 5 Click Yes in the Save Node Position dialog box.

CTC opens a progress bar and saves the new node positions.

Note Retrieve, Provisioning, and Maintenance users can move nodes on the network map, but only 
Superusers can save new network map configurations. To restore the view to a previously saved 
version of the network map, right-click the network view map and choose Reset Node Position.

Stop. You have completed this procedure.

Command or Action Purpose

Step 1 show mpls traffic-eng lmp interface 
[interface-type interface-instance]

Example:
router(config-if)# show mpls traffic-eng 
lmp interface TenGigE 0/1/0/1

Displays the interface resource or a summary of link management 
information. From the output of the show command, write down 
the value of the Local TE Link ID and the Local Data Link ID 
parameters.

Step 2 Return to your originating procedure (NTP). —

Purpose This procedure allows a Superuser to create a consistent network view for 
all nodes on the network, meaning that all users see the same network view 
on their login nodes.

Tools None

Prerequisite Procedures This procedure assumes that network turn-up is complete.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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NTP-G325 View the Power Levels of Cisco ONS 15454 MSTP 
Nodes

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 to log in to an ONS 15454 MSTP node on 
the network.

Step 2 In the network view, node view (single-node mode), multishelf view (multishelf mode), or card view 
click the Circuits tab.

Note An OCHNC or OCH trail circuit must exist on the optical path on which PPT is launched.

Step 3 Select the OCH trail and click Edit. The Edit Circuit window appears.

Step 4 In the Edit Circuit window, click the Photonic Path Trace tab.

Step 5 Click Start to start the PPT. The PPT creates a histogram that displays the power levels of the nodes 
versus the threshold levels.

Note The circuit must be in the DISCOVERED state to start the PPT.

Step 6 Click Export to export the data in the form of HTML.

Stop. You have completed this procedure.

Purpose This procedure displays the power levels of the ports of the ONS 15454 
MSTP nodes that traverse through an OCH or OCHNC trail using the 
Photonic Path Trace (PPT). The results are displayed in a histogram.

Tools None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G326 Provision SRLG on the Cisco ONS 15454 MSTP 
Network

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 to log in to an ONS 15454 MSTP node on 
the network.

Step 2 To assign, modify, delete, or reset the SRLG attributes for the nodes or links, perform the following 
steps:

a. Click the Manage SRLGs option in the Tools > Manage IPoDWDM menu. The SRLG Management 
wizard appears.

b. Choose one of the following options from the Select Type drop-down list:

– Manage Node SRLG—To add or update the node SRLGs.

– Manage Link SRLG—To add or update the link SRLGs.

c. Click Next.

d. In the Manage SRLG page, complete the following fields:

– If you chose the Manage Node SRLG option in Step b., select the node from the Node 
drop-down list. If you the chose Manage Link SRLG option in Step b., select the span from 
the Link drop-down list.

– In the Unique SRLG field, an SRLG number is displayed. You can edit the value. If the SRLG 
value already exists, a message is displayed.

To reset the SRLG value, click Set Default. A confirmation box is displayed. Click Yes.

Note The unique SRLG range is from 0 to 4294967294.

– To add an additional SRLG, type a numeric value in the Additional SRLG field and click Add.

If the SRLG value already exists, a message is displayed.

Note A maximum of 20 SRLGs can be added to the SRLG list.

– To delete an additional SRLG, choose the value from the SRLG list and click Delete. To reset 
the value, click Set Default. A confirmation box is displayed. Click Yes.

e. Click Finish to exit the wizard.

Purpose This procedure provisions Shared Risk Link Groups (SRLGs) for MSTP 
nodes and spans of the currently managed network using the SRLG 
management wizard. The SRLG information can be synchronized on Cisco 
CRS-1 routers and viewed as reports.

Tools None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 To view the SRLG values of the nodes and links, perform the following steps:

• To view the SRLG values for the OTS, OSC, or PPC links, go to the Network view and right-click 
the link, or place the mouse pointer over the link to see the SRLG value as a tooltip.

• To view the node SRLG values, click the Provisioning > General tab in the node view (single-shelf 
mode) or shelf view (multishelf view).

Step 4 To synchronize the SRLG information on the Cisco CRS-1 router, go to Network view, right-click the 
router and choose Synchronise IPoDWDM from the shortcut menu.

Step 5 Complete the “DLP-G540 View SRLG Reports” section on page 6-65 to view SRLG reports.

Stop. You have completed this procedure.

DLP-G540 View SRLG Reports

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-26 to log in to an ONS 15454 MSTP node on 
the network.

Step 2 To view the SRLG reports, perform the following steps:

• To view the consolidated SRLG report, click the Consolidated SRLG Report option in the Tools 
> Manage IPoDWDM > SRLG Report menu. The report displays the following information:

– Resource Name—Displays the node name or link name.

– Resource Type—Displays the resource type (node or link).

– Unique SRLG—Displays the unique SRLG value.

– Additional SRLG—Displays additional SRLG values.

• To view the detailed SRLG report, click the Detailed SRLG Report option in the Tools > Manage 
IPoDWDM > SRLG Report menu. The report displays the following information:

– Resource Name—Displays the node name or link name.

– Resource Type—Displays the resource type (node or link).

– SRLG Id—Displays the SRLG value.

– SRLG Type—Displays the SRLG type (unique or additional).

Step 3 Return to your originating procedure (NTP).

Purpose This task explains how to view SRLG reports.

Tools None

Prerequisite Procedures NTP-G326 Provision SRLG on the Cisco ONS 15454 MSTP Network, 
page 6-64

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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